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Smart Configurator for RZ 
User's Guide 
Introduction 
This application note describes the basic usage of the RZ Smart Configurator (hereafter called the Smart 
Configurator)  

Target Device 
Refer to the following URL for the range of supported devices and compilers: 

https://www.renesas.com/software-tool/rz-smart-configurator 

  

https://www.renesas.com/software-tool/rz-smart-configurator
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1. Overview 
1.1 Purpose 
This application note describes the basic usage of the Smart Configurator tool for the RZ device family.  

 

1.2 Features 
The Smart Configurator is a utility for configuring pin multiplexing settings, resolving conflicts, and generating 
pin initialization code. 

 

2. Creating a Smart Configurator project 
The following describes the procedure for creating a Smart Configurator project. 

(1) Launch the Smart Configurator and select [File] → [New]. 

(2) Select a device, e.g. R8A77450 from the left panel of the [New Smart Configuration File] dialog box. 
Specify the [File name] and click [Finish] button as shown below.  

 

Figure 2-1  Creating a New Smart Configurator File 
 

 
 
 
 

 

 
 

(1) 

(2) 
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3. Operating the Smart Configurator 
3.1 Procedure for Operation 
Figure 3-1 shows the procedure for using the Smart Configurator to set up pin and DDR parameter settings, 
generating source code and report.  

 
Figure 3-1  Procedure for Operations 

 

3.2 File to be saved as Project Information 
The Smart Configurator saves the setting information such as the target MCU for the project, build tool, 
peripheral modules, and pin functions in a project file (*.scfg), and refers to this information. The project file 
from the Smart Configurator is saved in this following format “<project name>.scfg”. 

 

 

  

 

Start the Smart Configurator launch 

Create and load a Smart Configurator 
  

Configure pins, DDR parameters 

Generate source code 

Generate reports 

Refer to section 3.4. Pin Settings, 
3.5 DDR Configurator 

Refer to chapter 4. Generating Source 
Code. 

Refer to chapter 5. Generating 
 

Refer to chapter 2. Creating a Smart 
Configurator project 
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3.3 Window  
The configuration of the Smart Configurator perspective is shown in Figure 3-2  Smart Configurator 
Perspective. 

 

Figure 3-2  Smart Configurator Perspective 
 

1) Smart Configurator editor with Board, Pins and DDR page, along with Install Utility and DDR Tools 
editors 

2) MCU Package view 

3) Console view 

4) Configuration Problems view 
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3.3.1 MCU Package view 
The states of pins are displayed on the figure of the MCU package. The settings of pins can be modified from 
here.  

Two types of package view can be switched between [Assigned] and [Default Board]. [Assigned] displays the 
assignment status of the pin setting, and [Default Board] displays the initial pin setting information of the 
board. The initial pin setting information of the board is the pin information of the board selected by [Board:] 
on the [Board] page (refer to "3.3.4 Selecting the board"). 

 

 
Figure 3-3  MCU Package View    

Select [Window] → [Show View] → [Smart Configurator] → [MCU Package] to open the MCU Package View. 
 
 

3.3.2 Console view 
 
The Console view displays details of changes to the configuration made in the Smart Configurator or MCU 
Package view. 
 

 
Figure 3-4  Console View 

Select [Window] → [Show View] → [General] folder dropdown menu and→ [Console] from the [Show View] 
dialog box in the Smart Configurator to open the Console View. 
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3.3.3 Configuration Problems view 
 
The Configuration Problems view displays the details if there’s any problem related to pin assignment. 

 
Figure 3-5  Configuration Problems View 

Select [Window] → [Show View] → [Smart Configurator] folder dropdown menu and → [Configuration 
Problems] from the [Show View] dialog box in the Smart Configurator to open the Configuration Problems 
view. 

Note: To change the device, perform from “3.8 MCU migration feature”. 
 

3.3.4 Selecting the board 
 
By selecting a board, the following settings can be changed at one time. 
 
• Pin assignment (Initial pin setting) 
• Target device 

 
The board setting information is defined in the Board Description File (.bdf). 

The .bdf file of Renesas made board (e.g. Renesas Starter Kit) can be downloaded from website and 
imported. 

In addition, by downloading the .bdf file provided by the alliance partner from website and importing it, it is 
possible to select alliance part boards. 

 
Figure 3-6  Selecting the Board 

Note: Depending on the board selected. If there is a change in the device, change the device suitable for that board 
from "0 MCU migration feature". 
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3.3.5 Exporting board settings 
 
Follow the procedure below to export the board settings. 

(1) Click the [  (Export board setting)] button on the [Board] tabbed page. 

(2) Select the output location and specify a name (Display Name) for the file to be exported. 

 
Figure 3-7  Exporting Board Settings (bdf Format) 

 

3.3.6 Importing board settings 
 
Follow the procedure below to import board settings. 

(1) Click on the [  (Import board setting)] button and select a desired bdf file. 

(2) The board of the imported settings is added to the board selection menu. 

 
Figure 3-8  Importing Board Settings (bdf Format) 

Once a board setting file is imported, the added board is also displayed in the board selection menu of other 
projects for the same device group. 

(1) 

(1) 

(2) 
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3.4 Pin Settings 
The [Pins] page is used for assigning pin functions. Click on the [Pin Function] and [Pin Number] tabs to 
switch between the 2 pages. The [Pin Function] list shows the pin functions for each of the peripheral 
functions, and the [Pin Number] list shows all pins in order of pin number. 

Figure 3-9  [Pins] Page ([Pin Function]) 
 

Figure 3-10  [Pins] Page ([Pin Number]) 

Display switching 
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When you select a board on the [Board] page, the initial pin setting information of the board is displayed in 
[Default Function]. In addition, the [ ] icon displayed in the [Function] selection list indicates the initial pin 
function of the board. 

3.4.1 Assigning pins using the MCU Package view 
 
The Smart Configurator visualizes the pin assignment in the MCU Package view. You can save the MCU 
Package view as an image file, rotate it, and zoom in to and out from it. 

Follow the procedure below to assign pins in the MCU Package view. 

(1) Zoom in to the view by clicking the [  (Zoom in)] button or scrolling the view with the mouse wheel. 

(2) Right-click on the target pin.  

(3) Select the signal to be assigned to the pin. 

(4) The color of the pins can be customized through [Preference Setting...]. 
 

           

 
Figure 3-11  Assigning Pins Using the MCU Package View  

       
  

(1) 

(2) 

(3) 

(4) 
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3.4.2 Exporting pin settings 
The pin settings can be exported for later reference. Follow the procedure below to export the pin settings. 

(1) Click on the [  (Export board setting)] button on the [Pins] page. 

(2) Select the output location and specify a name for the file to be exported.  

The exported XML file can be imported to another project having the same device part number. 

 
Figure 3-12  Exporting Pin Settings to an XML File 

The Smart Configurator can also export the pin settings to a CSV file. Click on the [  (Save the list to .csv 
file)] button on the [Pins] page. 

  

(1) 
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3.4.3 Importing pin settings 
 
To import pin settings into the current project, click on the [  (Import board setting)] button and select the 
XML file that contains the desired pin settings. After the settings specified in this file are imported to the 
project, the settings will be reflected in the [Pin configuration] page. 

 
Figure 3-13  Importing Pin Settings from an XML File   
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3.4.4 Pin setting using board pin configuration information 
 
The initial pin configuration of the board can be set in a single operation. The following describes the 
procedure for collective setting of pins. 

(1) Select [Default Board] in the MCU Package. (The initial pin configuration of the board can be referred. 

(2) Open the [Pin Configuration] page and click the [Assign default board pins]  button. 

(3) When [Assign default board pins] dialog opens, click [Select all]. 

(4) Click [OK]. 

 
Figure 3-14  Setting for initial pin configuration 

Pin settings maybe selected all at once, or specified individually in procedure (3). 

  

(3) 

(2) 
(1) 

(4) 
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3.4.5 Pin filter feature 
 
The filter range on the [Pin Function] tab and [Pin Number] tab on the [Pins] page can be used to filter out 
pin functions for easy search. 

 
Figure 3-15  Filter for [Pin Function] tab   

 
Figure 3-16  Filter for [Pin Number] tab   
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3.5 DDR Configurator 
 

The Smart Configurator provides feature to configure DDR parameters and pin function assignments. 

 

3.5.1 Setting parameters and pin assignment of DDR 
The [DDR] page is used for configuring DDR parameters and pin function assignments. 

(1) Configuration of DDR parameters allows to change manually Device Information, Mode Setting, and 
Analog Setting 

(2) Configuration of DDR pin function allows flexible assignment of pins for data, address, command, and 
control signals. 

Figure 3-17  [DDR] Page (DDR Parameters configuration) 
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Figure 3-18  [DDR] Page (DDR Pin Function assignment) 
 

3.5.2 Validating DDR Parameter configuration 
 

The [DDR] page includes a built-in conflict checker, 

When a parameter configuration conflicts with another parameter: 

(1) For conflicts outside the Device Information, errors are shown with a red ‘!’ over a yellow gear  in 
the Property column and a white ‘X’ within a red circle  in the Value column. 

(2) For conflicts within the Device Information, errors are shown only with a red ‘!’ over a yellow gear  
in the Property column. 

All Errors are also listed in the Configuration Problems view, making them easy to identify and address. 

 

 
Figure 3-19  Validating DDR Parameter configuration (Outside Device Information) 

 
 

Figure 3-20  Validating DDR Parameter configuration (Within Device Information) 
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3.5.3 Configuring the DDR Configurator Packages 

 
Follow the procedure below to configure the location of a specific DDR Configurator Packages. 

(1) Click [Browse…] of [DDR Configurator Packages] and navigate to the folder on the PC that contains 
the specific DDR Configurator Packages. 

(2) Click [Apply and Close] to apply the selected package path. 
 

           

 
Figure 3-21  Configuring DDR Configurator Packages 

Select [Window] folder dropdown menu and → [Preferences] in the Smart Configurator to open the [DDR] 
settings. 
  

(1) 

(2) 
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3.6 Install Utility 
 

The Smart Configurator provides feature to automated fundamental step which flashs bootloader and 
operation system disk image onto the targeted RZ/G board. 

 

3.6.1 GUI-Based Flashing Procedure for RZ/G Board 
 
Follow the procedure below to flash bootloader files and operating system disk image to RZ/G board. 

(1) Select a target device, e.g. RZ/G2L and specify the appropriate download mode (Normal or Fallback).  
Then provide the full paths to the bootloader binaries and the OS disk image file. 

(2) Select Flash Writer binary (.mot) which is loaded into the RZ/G board’s RAM during bootloader stage.  

(3) Select the Motorola S-record files (.srec) containing the bootloader components. BL2 and FIP each 
have their own .srec file, both of which are necessary for updating critical boot components during 
development or manufacturing. 

(4) Select operating system disk image file (.wic). This image will be written directly to the eMMC storage 
on the RZ/G board. 

(5) Select the appropriate COM port associated with the host PC's connection to the target board. 
Note: The GUI-based Install Utility supports simultaneous flashing of up to 8 boards. Ensure that the 
COM ports selected match the number of connected boards. 

(6) Select ‘Download” button to start the transfer and flashing of the selected bootloader and disk image 
files to the board. 

 

           

 
Figure 3-22  GUI-based flashing procedure for RZ/G boards  

Select [Tools] folder dropdown menu and → [Install Utility] in the Smart Configurator to open the Install Utility 
editor. 

Note:  

- Flashing the “.wic” image requires a U-Boot bootloader that supports the Fastboot protocol, which is 
part of the Android SDK Platform. For setup instructions, refer to section 3.6.2 Configuring the 
Android SDK Platform. 

  

(1) 

(2) 
(3) 
(4) 

(5) 

(6) 

(5) 
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- U-Boot also requires USB function recognized as "Android Device" in Device Manager. If "Other 
devices/USB download gadget" exists, open its properties and install the driver from the folder where 
you downloaded the Google USB Driver: https://developer.android.com/studio/run/win-usb  

 
 

3.6.2 Configuring the Android SDK Platform 
 
Follow the procedure below to configure the location of Android SDK Platform on the host PC. 

(1) Click [Browse…] of [SDK platforms] and navigate to the directory where the Android SDK Platform is 
installed on the host machine. 
Note: If the Android SDK Platform is not yet installed, download it from the official Android developer 
website: 
https://developer.android.com/tools/releases/platform-tools  

(2) Click [Apply and Close] to apply the selected SDK path. 
 

           

 
Figure 3-23  Configuring Android SDK Platform  

Select [Window] folder dropdown menu and → [Preferences] in the Smart Configurator to open the [DDR] 
settings. 

 
  

(1) 

(2) 

https://developer.android.com/studio/run/win-usb
https://developer.android.com/tools/releases/platform-tools
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3.6.3 Console-Based Flashing Procedure for RZ/G Board 
 
Console-Based flashing procedure requires the following prerequisites: 

 Operating System Requirements 

 Windows, Linux, and macOS: 

 Android SDK Platform Tools: Ensure the latest version are installed for Fastboot Tool and added 
to the system’s environment path. 
For example (Windows): Add the path to the “Android SDK Platform Tools” to the System 
Environment Variables under the PATH setting. 

           

Figure 3-24  Configuring PATH System variables for Android SDK Platform  
 Java SE 21: Required be installed on the PC. 

 Windows only: 

 Google USB Driver: Required be installed for device detection. 

 

Follow the procedure below to flash bootloader files and operating system disk image to RZ/G board for each 
OS environment by using command line: 

 On Windows 

 Open a terminal (Command Prompt) 

 Navigate to the folder containing InstallUtilityc.exe using the cd command. 

 
Note:  
- Replace this path with the actual location where InstallUtilityc.exe is installed 

 Run the following command (e.g: RZG3S): 

 
Note:  
- This is a single command. In Windows, the ^ character allows you to split the command into 
multiple lines for readability. 

 

(1) 
(2) 

cd C:\Renesas\Tools\InstallUtility\ 

InstallUtilityc.exe -p COM10 -d RZ/G3S -m Normal^ 

-fw <path_to_flash_writer>\Flash_Writer_SCIF_RZG3S_SMARC_LPDDR4.mot ^ 

-bl2 <path_to_bl2>\bl2_bp_emmc-smarc-rzg3s.srec ^ 

-fip <path_to_fip>\fip-smarc-rzg3s.srec ^ 

-wic <path_to_wic>\core-image-bsp-smarc-rzg3s.rootfs.wic.gz ^ 

-cfile <path_to_c_file>\G3S_LPDDR_parameters.c 
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 On macOS 

 Open the Terminal 

 Run the following command (e.g: RZG3S): 

 
Note:  
- This is a single command. In macOS, the \ character allows you to split the command into multiple 
lines for readability. 
- Must use the absolute path to the InstallUtility binary. Relative paths will not work. 

 On Linux 

 Open a terminal 

 Run the following command (e.g: RZG3S): 

 
Note:  
- This is a single command. In Linux, the \ character allows you to split the command into multiple 
lines for readability. 

Option descriptions: 

• -p <port_name>: USB serial port name: 

- Windows: COM1, COM10, etc. 

- macOS: tty.usbserial-0001 

- Linux: ttyUSB1 

• -d <device >: Target RZ device (e.g., RZ/G3S). 

• -fw < file path >: Path to Flash Writer .mot file. 

• -bl2 < file path >: Path to BL2 .srec file. 

• -fip < file path >: Path to FIP .srec file. 

• -wic < file path >: Path to WIC image .wic file. 

• -cfile <file path>: Path to DRAM parameters .c file. 
Note: This option is only required for RZ/G3S devices. Do not include it for RZ/G2L or other devices. 

  

/<absolute_path_to_installutility>/InstallUtility -p tty.usbserial-0001 -d RZ/G3S -m Normal\ 

-fw /<path_to_flash_writer>/Flash_Writer_SCIF_RZG3S_SMARC_LPDDR4.mot \ 

-bl2 /<path_to_bl2>/bl2_bp_emmc-smarc-rzg3s.srec \ 

-fip /<path_to_fip>/fip-smarc-rzg3s.srec \ 

-wic /<path_to_wic>/core-image-bsp-smarc-rzg3s.rootfs.wic.gz \ 

-cfile <path_to_c_file>\G3S_LPDDR_parameters.c 

./InstallUtility -p ttyUSB0 -d RZ/G3S -m Normal\ 

-fw /<path_to_flash_writer>/Flash_Writer_SCIF_RZG3S_SMARC_LPDDR4.mot \ 

-bl2 /<path_to_bl2>/bl2_bp_emmc-smarc-rzg3s.srec \ 

-fip /<path_to_fip>/fip-smarc-rzg3s.srec \ 

-wic /<path_to_wic>/core-image-bsp-smarc-rzg3s.rootfs.wic.gz \ 

-cfile <path_to_c_file>\G3S_LPDDR_parameters.c 
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3.7 DDR Tools 
 

The Smart Configurator provides feature to support the configuration, tuning, and validation of DDR memory 
interfaces on the RZ/G board. This functionality is essential for ensuring proper DDR initialization and stable 
operation within defined timing margins - critical during system bring-up and prior to OS boot. 

 

3.7.1 Configuring, tuning, and validating DDR memory 
 
Follow the procedure below to configure, tune, and validate DDR memory. 

(1) Select the target device, e.g. RZ/G3S 

(2) Specify the full paths for the DDR Tools file (*.mot) and the DDR configuration files (*.c). 

(3) Enable “Eye Opening check” to evaluate the timing margin between the DQS and DQ signals, 
ensuring reliable data capture. 

(4) Enable “Stress checker” to verify DDR stability under harsh conditions such as temperature 
fluctuations, voltage variations, and extended operation. Four test modes are available (selectable 
individually or in combination). 

• Basic Read/Write Check 

• Simple Read/Write Check 

• Random Data Read/Write Check 

• Fixed Data Read/Write Check 

(5) Select the correct COM port associated with the host PC's connection to the target board. 

(6) Select ‘Start” button to initiate DDR memory validation on the RZ/G board. 

(7) Once validation is completed, all logs will be listed as hyperlink in the “Test results” table, making 
them easy to identify and access. 

(8) Upon completion of the “Eye Opening check”, an Eye-Opening chart is generated. This chart is a 
graphical representation which shows the voltage of digital signals over time, helping engineers 
evaluate signal clarity and stability during data transmission. 
Click “View eye diagrams” to display the Write and Read charts. Refer to Figure 3-26  Write and 
Read charts for an example. 

           

 
Figure 3-25  Configuring, tuning, and validating DDR memory 

 

(1) 

(8) 

(2) 

(3) 
(4) 

(5) (6) 

(7) 



Smart Configurator for RZ User's Guide 

R20AN0823ES0100  Rev.1.00  Page 24 of 31 
Dec 22, 2025  

           

 
Figure 3-26  Write and Read charts 

 
Select [Tools] folder dropdown menu and → [DDR Tools] in the Smart Configurator to open the DDR Tools 
editor. 

 
3.7.2 Configuring the DDR Tools Packages 

 
Follow the procedure below to configure the location of a specific DDR Tools Packages. 

(3) Click [Browse…] of [DDR Tools Packages] and navigate to the folder on the PC that contains the 
specific DDR Tools Packages. 

(4) Click [Apply and Close] to apply the selected package path. 
 

           

 
Figure 3-27  Configuring DDR Tools Packages 

Select [Window] folder dropdown menu and → [Preferences] in the Smart Configurator to open the [DDR] 
settings. 

 
  

(1) 

(2) 
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3.8 MCU migration feature 
The MCU migration feature helps to convert user project settings from device A to device B. Conversion of 
project settings can be done within the same family and can be done from Smart Configurator as follows. 

Note: Project settings may change due to device change. It is recommended to back up the smart configurator project 
file (*.scfg) before executing the device change. 
 

(1) Open the [Device Selection] page by clicking on the [Board] tab view. 

 
Figure 3-28  [Device Selection]   

 
(2) Click on this icon     and select the target device from the device dropdown menu list. 

 
Figure 3-29  Select target device 

 
(3) Select Save and continue Or Continue to change to another target device. (E.g. change to RZ/G1H). 

 
Figure 3-30  Confirm device change 
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(4) Migration report will be generated, the report information is displayed in console window. 

 
Figure 3-31  Output Migration report 

(5) The migration report can be opened by clicking the hyperlink string in the console window. The 
reports content will show the pin configuration porting status. 

 
Figure 3-32  Migration report content 

 
4. Generating Source Code 
4.1 Outputting Generated Source Code 

Output a source file for the configured details by clicking on the [  (Generate Code)] button in the Smart 
Configurator view. 

 
Figure 4-1  Generating a Source File 
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4.2 Configuration of Generated Files and File Names 
 
Figure 4-2 shows the folders and file output by Smart Configurator. For the RZ/G2x and RZ/G3x device series, 
a single *.dtsi file is generated in the device tree syntax for Linux. For RZ/G3x device using DDR Configurator 
tool, an additional *.c file is generated in the include folder. 
The generated source code feature is valid only for the RZ/G2x and RZ/G3x device series. For RZ/A1x and 
RZ/G1x device, no source file is generated. 
 

 

  
Figure 4-2  Configuration of Generated Files and File Names 

 
 
 
 
 
  
 
 
  

Folder File Description 
src/smc_gen/dts  This folder is always generated. 

It consists of only r8axxxx_pinconf.dtsi or 
r9axxxx_pinconf.dtsi file. 

r8axxxx_pinconf.dtsi 
r9axxxx_pinconf.dtsi 

This file is always generated. 
It represents a set of text files in the Linux kernel 
source tree that describe the hardware of the RZ/G 
device tree. 

src/smc_gen/inc  This folder is always generated for the RZ/G3x 
device. 
It consists of only param_ddrinit.c file. 

 param_ddrinit.c This file is always generated for the RZ/G3x device. 
It’s a C source file (.c) that defines DDR initialization 
parameters, which will be converted into a binary file 
(.bin) for consistent use across DDR Tools and Install 
Utility. 

smc_gen 

dts 

inc 

r8axxxx_pinconf.dtsi 

r9axxxx_pinconf.dtsi 

param_ddrinit.c 

src 
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5. Generating Report on Smart Configurator 
The Smart Configurator generates a report on the configurations that the user works on. Follow the 
procedure below to generate a report. 

5.1 Report on Device Configurations 

A report is output by clicking on the [ (Generate Report)] button in the Smart Configurator view. 
 

 
 

Figure 5-1 Output of a Report on the Configuration (as a Text File) 

 
Figure 5-2  Dialog Box for Output of a Report 
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5.2 Configuration of Pin Function List and Pin Number List (in csv Format) 
 
A list of the configuration of pin functions and pin numbers is output by clicking on the [  (Save the list to .csv 
file)] button on the [Pins] page of the Smart Configurator view. 

 
Figure 5-3  Output of a List of Pin Functions or Numbers (in csv Format) 

 

5.3 Image of MCU Package (in png format) 

An image of the MCU package is output by clicking on the [  (Save Package View to external image file)] 
button of the [MCU Package] view. 

 
Figure 5-4  Output an image of the MCU Package (in png Format) 
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6. Help 
Refer to the help dropdown menu for detailed information on the Smart Configurator. 

 
Figure 6-1  Help Menu 

 
 

  

7. Documents for Reference 
User’s Manual: Hardware  
Obtain the latest version of the manual from the Renesas Electronics website. 
 
Technical Update/Technical News 
Obtain the latest information from the Renesas Electronics website. 

 
Website and Support  
Renesas Electronics Website 

http://www.renesas.com/ 
Inquiries 

http://www.renesas.com/contact/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
All trademarks and registered trademarks are the property of their respective owners.  

http://www.renesas.com/
http://www.renesas.com/contact/
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020) 

 
Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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